MS ACCESS SAVE REPORT TO pdf
1: News, Tips, and Advice for Technology Professionals - TechRepublic
I simply want a vba script that I can run over and over again to save the same Access report (that changes as the weeks
go by) into the same file over and over again. I need it to be the same name each time and don't want to be prompted
that the filename is already there.

Otherwise, if you want to DIY, you can read the contents below. Add a command button inside your report
This article assumes that you already have an Access Report created. Open it in design view and add a button
in the Report header as shown below. While in design view, select the button. Add code for the command
button To add the code, you have to first add an On Click event to the button. With the command button
selected, go again to the Property Sheet. Click on the Event tab. This will open the VBA Editor. Now, copy
the code below. First check if a PDF file with the same filename already exists in the specified folder. If it
does, a prompt will appear asking if you would like to replace it with a new one. If you select yes, the report
will continue with the export process. If not, the file will not be converted to PDF. If you entered a folder path
that does not exist, a prompt will appear to ask you to update the folder path specified in the code. Export
process will not continue until this is corrected. Once the report has been successfully exported, a prompt will
appear indicating where the PDF file was saved. Unable to Open Access Database The most terrifying thing
that can happen to any Access user is to wake up one day and realize that the database could no longer be
opened. It has been corrupted. Your database can still be brought back to life. Jayme Stack is a data recovery
expert in DataNumen, Inc. For more information visit www.
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2: how can i export a report to a jpg format? | PC Review
1. Launch Microsoft Access on your computer. Click the "File" tab and then click "Open." Open the Access database that
contains the report you want to export to Excel.

Small business users who prefer the convenience of Excel tables when it comes to anything from sales data to
customer records can easily convert reports generated by Access to Excel tables with an automated feature in
Access. Open your Access database. Generate the report you need from your database by clicking its name in
the lower left-hand column of your database under "Reports. Click the "External Data" tab from the Access
Ribbon along the top of the window and then click the Excel icon, which is the second from the left in the
Export group of the External Data menu. Wait for the "Export - Excel Spreadsheet" dialog box to open. Click
the "Browse" button at the end of the "File name: Wait for the File Save dialog box to appear. Select the drive
and folder to which you want to save the Excel spreadsheet version of the report. Type the name under which
you want to save the file in the "File name: Select the particular Excel format in which you want to save your
spreadsheet using the File format pull-down menu in the Export - Excel Spreadsheet dialog box. Make sure
the box next to "Export data with formatting and layout," which is usually the default option, is checked for
the best results. Click the "Save" button at the bottom of the dialog box to return to the main box. Check the
box to the left of "Open the destination file after the export operation is complete" if you want to work on your
Excel file as soon as you export your data. Check the box to the left of "Export only the selected records" if
you set up your report using only specified records. This box usually cannot be selected unless you have
generated a particular custom report using only specific records from your database. Click the "OK" button at
the bottom of the dialog box. Check the "Save export steps" box in the dialog box if you want to save your
export steps for future use. Enter a name and description as you wish and click the "Save Export" button. Wait
for your Excel spreadsheet to open in another window if you checked the pertinent box in Step 8. Open Excel
and browse for the spreadsheet by name if you did not check the box. Work on your Excel spreadsheet as you
would any other spreadsheet but pay attention to dialog boxes that will ask you whether you want to change
data from your Access report. Tip Save your export steps as an Outlook task if you wish by clicking the
"Create Outlook" task box on the final dialog box. Create the task by waiting for Outlook to open and
following the prompts that appear in the dialog boxes that follow. Photo Credits black database image by.
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3: Export access report to excel xlsx
Saving a Report. The final step is to save the report object. Note: This can be done at any time during report creation.
When you click on the 'Save' button (icon with disk) in the toolbar at the top of the page, a "Save As" window should
appear as in the example below.

Send your report as an e-mail message Choose a record source A report consists of information that is pulled
from tables or queries, as well as information that is stored with the report design, such as labels, headings,
and graphics. If the fields that you want to include all exist in a single table, use that table as the record source.
If the fields are contained in more than one table, you need to use one or more queries as the record source.
Those queries may already exist in your database, or you may need to create new queries specifically to fit the
needs of your report. Create a report by using the Report tool The Report tool provides the fastest way for you
to create a report, because it generates a report immediately without prompting you for information. The report
displays all the fields from the underlying table or query. The Report tool may not create the final, polished
product that you ultimately want, but it is quite useful as a means to quickly look at the underlying data. You
can then save the report and modify it in Layout view or Design view so that it better serves your purposes. In
the Navigation Pane, click the table or query on which you want to base the report. On the Create tab, in the
Reports group, click Report. Access builds the report and displays it in Layout view. For more about viewing
and printing your report, see the section View, print, or send your report as an e-mail message. After viewing
the report, you can save it and then close both the report and the underlying table or query that you used as a
record source. The next time that you open the report, Access will display the most recent data from your
record source. Create a report by using the Report Wizard You can use the Report Wizard to be more selective
about what fields appear on your report. You can also specify how the data is grouped and sorted, and you can
use fields from more than one table or query, provided you have specified the relationships between the tables
and queries beforehand. On the Create tab, in the Reports group, click Report Wizard. Follow the directions on
the Report Wizard pages. On the last page, click Finish. When you preview the report, you see the report as it
will appear in print. You can also increase the magnification to zoom in on details. If you want to include
fields from multiple tables and queries in your report, do not click Next or Finish after you select the fields
from the first table or query on the first page of the Report Wizard. Instead, repeat the steps to select a table or
query, and click any additional fields that you want to include in the report. Then, click Next or Finish to
continue. Create labels by using the Label Wizard Use the Label Wizard to easily create labels for a wide
variety of standard label sizes. In the Navigation Pane, open the table or query that will be the record source
for your labels by double-clicking it. On the Create tab, in the Reports group, click Labels. Follow the
directions on the pages of the Label Wizard. Access displays your labels in Print Preview so that you can see
them as they will appear when they are printed. You can use the slider control on the Access status bar to
zoom in on details. For more information about viewing and printing your report, see the section View, print,
or send your report as an e-mail message. This can be a very quick way to build a report, especially if you plan
to put only a few fields on your report. The following procedure explains how to use the Blank Report tool:
On the Create tab, in the Reports group, click Blank Report. A blank report is displayed in Layout view, and
the Field List pane is displayed on the right side of the Access window. In the Field List pane, click the plus
sign next to the table or tables containing the fields that you want to see on the report. Drag each field onto the
report one at a time, or hold down CTRL and select several fields, and then drag them onto the report at the
same time. Understand the report sections In Access, the design of a report is divided into sections. You can
view your report in Design view to see its sections. To create useful reports, you need to understand how each
section works. For example, the section in which you choose to place a calculated control determines how
Access calculates the results. The following list is a summary of the section types and their uses: Use the
report header for information that might normally appear on a cover page, such as a logo, a title, or a date.
When you place a calculated control that uses the Sum aggregate function in the report header, the sum
calculated is for the entire report. The report header is printed before the page header. For example, use a page
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header to repeat the report title on every page. Use the group header to print the group name. For example, in a
report that is grouped by product, use the group header to print the product name. When you place a calculated
control that uses the Sum aggregate function in the group header, the sum is for the current group. This is
where you place the controls that make up the main body of the report. Use a group footer to print summary
information for a group. Use a page footer to print page numbers or per-page information. Use the report
footer to print report totals or other summary information for the entire report. In Design view, the report
footer appears below the page footer. However, when the report is printed or previewed, the report footer
appears above the page footer, just after the last group footer or detail line on the final page. Top of Page
Understand controls Controls are objects that display data, perform actions, and let you view and work with
information that enhances the user interface, such as labels and images. Access supports three types of
controls: You use bound controls to display values from fields in your database. A text box is the most
common type of bound control. You use unbound controls to display information, lines, rectangles, and
pictures. For example, a label that displays the title of a report is an unbound control. You specify the value
that you want in the control by defining an expression as the source of data for the control. For example, the
following expression calculates the price of an item with a 25 percent discount by multiplying the value in the
Unit Price field by a constant value 0. When you create a report, it is probably most efficient to add and
arrange all the bound controls first, especially if they make up the majority of the controls on the report. You
can then add the unbound and calculated controls that complete the design by using the tools in the Controls
group on the Design tab. You bind a control to a field by identifying the field from which the control gets its
data. You can create a control that is bound to the selected field by dragging the field from the Field List pane
to the report. The property sheet defines the characteristics of the control, such as its name, the source of its
data, and its format. Using the Field List pane is the best way to create a control for two reasons: A bound
control inherits many of the same settings as the field in the underlying table or query such as for the Format,
DecimalPlaces, and InputMask properties. Therefore, you can be sure that these properties for the field remain
the same whenever you create a control that is bound to that field. Using the actual report data as your guide,
you can adjust the column widths, rearrange the columns, and add grouping levels and totals. You can place
new fields on the report design and set the properties for the report and its controls. To switch to Layout view,
right-click the report name in the Navigation Pane and then click Layout View. Access shows the report in
Layout view. You can use the property sheet to modify the properties for the report and its controls and
sections. To display the property sheet, press F4. You can use the Field List pane to add fields from the
underlying table or query to your report design. To display the Field List pane, do one of the following: You
can add new controls and fields to the report by adding them to the design grid. The property sheet gives you
access to a large number of properties that you can set to customize your report. To switch to Design view,
right-click the report name in the Navigation Pane and then click Design View. Access shows the report in
Design view. You can use the property sheet to modify the properties for the report itself and the controls and
sections it contains. Top of Page Add fields from the Field List pane To add a single field, drag the field from
the Field List pane to the section where you want it displayed on the report. To add several fields at once, hold
down CTRL and click the fields that you want. Then, drag the selected fields onto the report. When you drop
the fields onto a report section, Access creates a bound text box control for each field and automatically places
a label control beside each field. Top of Page Add controls to the report Some controls are created
automatically, such as the bound text box control that is created when you add a field from the Field List pane
to your report. Many other controls can be created in Design view by using the tools in the Controls group on
the Design tab. Determine the name of a tool Place the mouse pointer over the tool. Access displays the name
of the tool. Create a control by using the tools in the Controls group Click the tool for the type of control that
you want to add. For example, to create a check box, click the Check Box tool. Click in the report design grid
where you want to position the upper-left corner of the control. Click once to create a default-sized control, or
click the tool and then drag in the report design grid to create a control of the size that you want. Click the
control to select it. Position the mouse pointer over the edge of the control until the pointer turns into a
four-headed arrow. Drag the control to the location that you want.
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4: Export dynamically filtered Access report to PDF - Codekabinett
Easily Save Access Reports as PDF Files. by Avantix Learning Team | Updated June 30, Applies to: Microsoft Â®
Access Â® , and If you have Microsoft Access or a later version, you can easily convert your Access reports to PDF
(Portable Document Format) without using Adobe Acrobat Pro.

Export a report to do the following: Work with the report data in another application. For example, you can
export your report to Excel and then continue to work with the data in Excel. Print the report in a different
format. For example, you can export the report to the PDF file format and then print it. Save a copy of the
report as another file type. For example, you can export a report to Word and save it, creating a copy of the
report. Use report data as data feeds in applications. For more information, see Generate Data Feeds from a
Report Rendering the report on the report server is useful when you set up subscriptions or deliver your
reports via e-mail, or if you want to save a report that is available on the report server. For more information,
see Subscriptions and Delivery Reporting Services. Reporting Services provides many rendering extensions,
supporting exports of reports to common file formats. Report pagination might be affected when you export a
report to a different format. When you preview a report, you are viewing the report as it is rendered by the
HTML rendering extension, which follows soft-page break rules. When you export a report to a different file
format, such as Adobe Acrobat PDF , pagination is based on the physical page size, which follows hard-page
break rules. Pages can also be separated by logical page breaks that you add to a report, but the actual length
of a page varies based on the renderer type that you use. To change the pagination of your report, you must
understand the pagination behavior of the rendering extension you choose. You might need to adjust the
design of your report layout for this rendering extension. For more information see, Page Layout and
Rendering. Note You can create and modify paginated report definition. Each authoring environment provides
different ways to create, open, and save reports and related items. To export a report from Report Builder Run
or Preview the report. On the ribbon, click Export. Select the format that you want to use. The Save As dialog
opens. By default, the file name is that of the report that you exported. Optionally, you can change the file
name. To export a report from the Reporting Services web portal From the Reporting Services web portal
Home page, navigate to the report that you want to export. Click the report to render and preview the report.
On the Report Viewer toolbar, click the Export drop-down arrow. A dialog appears asking you if you want to
open or save the file. To view the report in the selected export format, click Open. Using the application that is
associated with the format that you chose, the report is either displayed or saved. If you click Save, you will be
prompted for a location where you can save your report. To export a report from a SharePoint library Preview
the report. On the toolbar, click Actions, point to Export, and then select the format that you want to use. The
File Download dialog box opens. Optionally, change the file name of the exported report. Note If the program
cannot open the report in the format that you chose because you do not have a program associated with this
file type, you will be prompted to save the exported report or to find a program online to open the report. Data
renderer extensions Data rendering extensions strip all formatting and layout information from the report and
display only the data. The resulting file can be used to import the raw report data into another file type, such as
Excel, another database, an XML data message, or a custom application. Data renderers do not support page
breaks. The following data rendering extensions are supported: Soft page-break renderer extensions Soft
page-break rendering extensions maintain the report layout and formatting. The resulting file is optimized for
screen-based viewing and delivery, such as on a Web page or in the ReportViewer controls. The following soft
page-break rendering extensions are supported: Hard page-break rendering extensions Hard page-break
renderer extensions maintain the report layout and formatting. The resulting file is optimized for a consistent
printing experience, or to view the report online in a book format. The following hard page-break rendering
extensions are supported: Formats you can export while viewing reports Reporting Services provides
rendering extensions that render reports in different formats. You should optimize the report design for your
chosen file format. The followin table lists the formats you can export from the user interface. There are
additional formats you can use with Reporting Services subscriptions or if you are exporting from URL
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access. See the section Other Ways of Exporting Reports in this topic.
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5: Simple VBA code to export Access Report to saved PDF File when code is run - Stack Overflow
Access does not support exporting directly to a Word document .doc www.enganchecubano.com), but it can export
www.enganchecubano.com Only the text of the report will be exported, all graphics such as lines will be lost. Example.

Typically when the scope of the budget approved for the IT expenditure is low, businesses start with low cost
data management and reporting alternatives likes MS Access. As the volume of data keeps growing, so does
the volume and variety of reports. In this journey of organic growth, eventually a time kicks in when the IT
Department feels the inevitable need to migrate the data along with the reports to a more capable database
management system like SQL Server and SSRS. Considerable investment goes into building reports, and
redeveloping all the reports from scratch poses a sizeable challenge in terms of cost and schedule. This
situation demands an automated way to migrate reports from MS Access to SSRS to reduce partial efforts of
rebuilding the report layout and associated details from scratch. This feature should even work with SQL
Server Northwind is a sample MS Access database that is available from Microsoft, that contains samples
tables along with data, and few reports with it. In order to install a Northwind MS Access template, just follow
the steps mentioned below and in a couple of minutes you can install the Northwind template. Open the
created sample database, and you should be able to find reports under the "Reports" section, as shown in the
below image. Click on the "Import Reports" sub-menu, under the "Project" menu, and you should be able to
see the option of Microsoft Access as shown in the below image. After opening the MS Access dialog, select
the Northwind sample database that we just created in the above steps, and click Open. One thing to note here
is that these reports would not be totally error-free and ready for execution, as shown in the below image for
the Invoice report. There may also be missing data sources and datasets obviously, we the report developer
would have to fix these issues. Summary This raises the question that in this case why should one use this
feature at all and whether it is worth investing time in fixing a broken imported report or developing a new
report from scratch. The answer to this question is - it depends on the complexity of the report. Generally
speaking, highly complex reports having a large number of data fields and parameters are a good candidate for
this method of migration as this would save considerable time in re-designing the same report by continuously
comparing the new report with the older one. For reasonably smaller or simpler reports that can be developed
using the SSRS Report Wizard, it would be quicker to develop such reports from scratch. Once the reports are
imported, then one can selectively make a call on which ones make sense to fix and which ones can be totally
discarded and developed from scratch, depending upon the effort required to get the report up and running.
Next Steps Try to fix some of the issues on the Invoice report imported from MS Access, to get an idea how
the tasks can be done after the reports are imported. Check out all of the Microsoft Access tips.
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6: How to Convert Access Report to PDF - Universal Document Converter
Alternatively, click Save on the Quick Access Toolbar. If the report is untitled, type a name in the Report Name box, and
then click OK. Save your report design under a new name. If you're using Access or higher, click File > Save As > Save
Object As. If you're using Access , click File > Save Object As.

Forms and reports cannot be exported without their formatting. All fields and records in the underlying object
are exported. The Format property settings are ignored during the operation. For lookup fields, only the
lookup ID values are exported. For hyperlink fields, the contents are exported as a text column that displays
the links in the format displaytext address. With formatting Table, query, form, or report Only fields and
records that are displayed in the current view or object are exported. Filtered records, hidden columns in a
datasheet, and fields not displayed on a form or report are not exported. The wizard respects the Format
property settings. For lookup fields, the lookup values are exported. For hyperlink fields, the values are
exported as hyperlinks. For rich text fields, the text is exported but the formatting is not. Choose the
destination workbook and file format. During the export operation, Access prompts you to specify the name of
the destination workbook. The following table summarizes when a workbook is created if it does not already
exist and when it is overwritten if it does already exist. If the destination workbook And the source object is
And you want to export Then A table, query, form, or report The data, with or without the formatting The
workbook is created during the export operation. Already exists A table or query The data, but not the
formatting The workbook is not overwritten. A new worksheet is added to the workbook, and is given the
name of the object from which the data is being exported. If a worksheet having that name already exists in the
workbook, Access prompts you to either replace the contents of the corresponding worksheet or specify
another name for the new sheet. Already exists A table, query, form, or report The data, including the
formatting The workbook is overwritten by the exported data. All existing worksheets are removed, and a new
worksheet having the same name as the exported object is created. The data in the Excel worksheet inherits the
format settings of the source object. The data is always added in a new worksheet. You cannot append the data
to any existing worksheet or named range. Run the export operation If the destination Excel workbook is
open, close it before you continue. In the Navigation Pane of the source database, select the object that you
want to export. Export only a portion of the data If the object is a table, query, or form, and you want to export
only a portion of the data, open the object in Datasheet view and select the records you want. To open a form
in Datasheet view: Double-click the form to open it. Right-click the form, and then click Datasheet View. If
this option is not available: Press F4 to display the Property Sheet task pane. Select Form from the drop-down
list at the top of the Property Sheet. On the Design tab, in the Views group, click Datasheet View. You cannot
export a portion of a report. However, you can select or open the table or query that the report is based on, and
then export a portion the data in that object. On the External Data tab, in the Export group, click Excel. In the
Export - Excel Spreadsheet dialog box, review the suggested file name for the Excel workbook Access uses
the name of the source object. If you want, you can modify the file name. In the File Format box, select the
file format that you want. If you are exporting a table or a query, and you want to export formatted data, select
Export data with formatting and layout. For more information, see the section Prepare for the export operation.
If you are exporting a form or report, this option is always selected but unavailable it appears dimmed. To
view the destination Excel workbook after the export operation is complete, select the Open the destination
file after the export operation is complete check box. If the source object is open, and if you selected one or
more records in the view before starting the export operation, you can select Export only the selected records.
To export all the records displayed in the view, leave this check box cleared. This check box remains
unavailable dimmed if no records are selected. If the export operation fails because of an error, Access
displays a message that describes the cause of the error. Otherwise, Access exports the data and, depending on
your selection in step 7, opens the destination workbook in Excel. Access then displays a dialog box in which
you can create a specification that uses the details from the export operation. Top of Page What else should I
know about exporting? For information on how to run saved export specifications, see the article Run a saved
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import or export operation. For information on how to schedule specifications to run at specific times, see the
article Schedule an import or export operation. For information on how to change a specification name, delete
specifications, or update the names of source files in specifications, see the article Manage Data Tasks.
Troubleshoot missing and incorrect values The following table describes various ways of troubleshooting
common errors. If you find that just a few values are missing, fix them in the Excel workbook. Otherwise, fix
the source object in the Access database, and then repeat the export operation. Issue Description and resolution
Calculated fields The results of calculated fields are exported; the underlying expressions that perform the
calculations are not. Multivalued fields Fields that support multiple values are exported as a list of values
separated by semicolons ;. Pictures, objects, and attachments Graphical elements such as logos, contents of
OLE object fields, and attachments that are part of the source data are not exported. Add them to the
worksheet manually after you complete the export operation. Graph When you export a form or report that
contains a Microsoft Graph object, the graph object is not exported. Data in the wrong column Null values in
the resulting worksheet are sometimes replaced by the data that should be in the next column. Missing date
values Date values earlier than Jan 1, are not exported. The corresponding cells in the worksheet will contain a
null value. Missing expressions Expressions that are used to calculate values are not exported to Excel. Only
the results of the calculations are exported. Manually add the formula to the Excel worksheet after you
complete the export operation. Missing subforms, subreports, and subdatasheets When you export a form,
report, or datasheet, only the main form, report, or datasheet is exported. You must repeat the export operation
for each subform, subreport, and subdatasheet that you want to export. Missing or incorrectly formatted
columns If none of the columns appear to be formatted in the resulting worksheet, repeat the export operation,
being sure to select the Export data with formatting and layout check box in the wizard. Conversely, if only
some columns appear to be formatted differently from the versions in the source object, apply the formatting
that you want manually in Excel. Format a column in Excel Open the destination Excel workbook, and then
display the worksheet that contains the exported data. Right-click a column or a selected range of cells, and
then click Format Cells. This can be the result of starting the export operation from the Navigation Pane or in
Form view. To resolve this issue, open the form in Datasheet view before exporting the data. Error indicators
or error values Check the cells for error indicators green triangles in the corners or error values strings that
begin with the character instead of the appropriate data.
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7: How to Generate an MS Access Report to an Excel File | www.enganchecubano.com
Hello, I have the below vba in a button on a form which exports an Access report as a PDF with a custom name. How
can I modify it so that it also exports the same Access report as an xlsx to a folder.

There is one aspect of using this very convenient method that I frequently see people struggle with. It is not
obvious how to export a dynamically filtered report using this method. Other than the DoCmd.
OutputTo-Method does not support to supply any criteria to the report the filter the data. So, it seems to be a
problem to export a report that displays different data sets depending on user input or other factors. The
obvious workarounds that come to mind are usually one of the following: Create different reports with the
criteria built in Create a parameter query referencing form fields or global functions as record source for the
report. Build the SQL for the report at runtime and assign it to the report. All of these do work. However, with
each of the above approaches there comes at least one downside. Matching the above order: It requires to
create multiple very similar objects reports. It requires additional functions or a form and is rather inflexible.
While all these approaches work, I would rather not recommend to use any of them. Luckily there is a very
simple solution to the problem that is just not so obvious. If the report you are exporting is closed when you
invoke DoCmd. OutputTo, the OutputTo-Method will open the report and export it. However, if the report you
want to export is open already in preview acViewPreview when you invoke OutputTo, the DoCmd.
OutputTo-Method will just export the report as it is! Considering this, it is very simple to solve the problem
with exporting dynamically filtered reports. You open the report using DoCmd. To prevent the report
appearing on the screen in preview, you use the WindowMode acHidden, to open the report invisible to the
user. You then simply invoke DoCmd. There is only one thing that you must not forget to take care of. After
opening the report in preview view, it will stay open, albeit invisible, until you explicitly close it. OpenReport,
the report will become visible but it will not re-query the data and will it still use the original criteria for
filtering the data. In this case the report might display the wrong data set. Always close the hidden report after
the PDF file was saved. Taking all this into account, our procedure to export a filtered report to PDF could
look like this: Close acReport, reportName, acSaveNo End Sub In a real-world implementation, based on this
sample, you can pass in all 3 variables as arguments into the function and thus create a simple and flexible
ExportToPDF routine for your Access application. So, here we are. An elegant, yet very easy to implement,
solution and it requires only 2 additional lines of code. I recorded a demonstration of the solution described
here on video and published it to YouTube. You can unsubscribe any time. This email list is hosted at
Mailchimp in the United States. The data is covered by the EU-U. See our privacy policy for further details.
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8: VBA to export a report as Excel file - Microsoft Community
By using the Export Wizard, you can export data from an Access database to in a file format that can be read by
Microsoft Excel. This article shows you how to prepare and export your data to Excel, and also gives you some
troubleshooting tips for common problems that can occur.

Click a field and then click the single-right arrow to select a single field, click the double-right arrows to select
all fields, click a field and then click the single-left arrow to deselect a single field, or click the double-left
arrow to deselect all fields. Repeat steps 1 and 2 for each table from which you want to select fields. The
Report Wizard moves to the next page. Group When using the Report Wizard, you can group data. For
example, if your data is grouped by the Department field and the records in the Department field have values
such as Administration, Computer Science, and English. Access will group all of the data for the
Administration department together, all of the data for the Computer Science department together, and all of
the data for the English department together. Click to select the field by which you want to group your data.
You may not see this page of the wizard if you are selecting data from a single table. Click a field you want to
group by. Click the right-arrow to select a field; click a field and then click the left arrow to deselect a field.
Use the up- and down-arrows to change the order of the groupings. If you are only using one table, this may be
your first opportunity to select a field to group by. Repeat steps 3 and 4 for each field you want to group by.
Sort and summarize By using the Report Wizard, you can create up to four levels of sort. Access sorts the first
level, and then sorts the second level within that sort, and so on. If you have grouped your data, you can
summarize it by displaying the sum, average, and minimum or maximum value for each numeric field. You
can choose to have your report display just the summary data or each detail line and the summary data. There
is also an option that allows you to display the percent the sum of each group is of the grand total. All of the
fields in your report may not fit on a single page. You can have Access automatically adjust the size of the
font so that every field fits. Click the down-arrow and then select the field you want to sort by. Click the
button to choose ascending or descending order. Clicking the button toggles between Ascending and
Descending. You can sort up to four levels. Click the Summary Options button. The Summary Options
window appears. Click to select the summary data you want. Click to select whether you want detail and
summary data or if you want summary data only. Click if you want to calculate the percent to the total for
sums. The Summary Options window closes. Layout and orientation You can choose the layout and
orientation of your report. The layout determines where each field appears on the page. Access provides three
options to choose from: Stepped, Block, and Outline. When you choose an option, the left side of the window
displays a graphic of the layout. Orientation determines whether Access creates the report in portrait or
landscape. If you print in Portrait, the shortest edge of the paper becomes the top of the page. Portrait is the
default option. If you print Landscape, the longest edge of the paper becomes the top of the page. Click to
select a layout. Click to select a page orientation. Style A style is a set of formats consisting of such things as
background colors, fonts, font colors, and font sizes. Access supplies predesigned styles that format titles,
labels, and more. When you choose a style, the left side of the window displays a preview. Click to select a
style. On the final page of the Report Wizard, you can title your report. The title appears at the top of the
report and on the Navigation pane. Type the title you want to give the report. Access creates, saves, and opens
your report in Layout view. Reports created with the Report Wizard may have the following two sections in
addition to the sections found in reports created by using the Report button. Sections of a Report Appears
before a group and displays information about the group. Group Footer Appears after a group and summarizes
the group data. Modify a Report After you create a report, you can modify it. You can add groups or sorts, add
fields, change labels, and perform many other tasks. You can modify a report in Layout view or Design view.
In Layout view, you can see your data, and the report you see closely resembles how your report will look
when you print it. You can make most, but not all, changes to your report in Layout view. Design view
displays the structure of your report. In this view you cannot see the underlying data, but you can perform
some tasks in Design view that you cannot perform in Layout view. This tutorial focuses on Layout view. To
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change to Layout view: Click the View button. Access changes to Layout view. Change the Size of a Field or
Label If the data in a field or label seems crowded, if some of the data in the field or label does not appear, or
if the data appears as pound signs , the field or label is too small. To change the size of a field or label: Click
the field or label. A border appears around it. Click a side of the border and drag outward to increase the
width. Click a side of the border and drag inward to decrease the width. Incidentally, if you want to change the
height of records, click the top or bottom of a field border and drag upward or downward. Add a Group or Sort
When you create a report by clicking the Report button, you are not given options that enable you to group or
sort. Activate the Format tab.
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Save a Microsoft Access Report to a File Exports an Access report to a snapshot file. Includes constant values for other
file formats.

Note Forms and reports cannot be exported without their formatting. All fields and records in the underlying
object are exported. The Format property settings are ignored during the operation. For lookup fields, only the
lookup ID values are exported. For hyperlink fields, the contents are exported as a text column that displays
the links in the format displaytext address. With formatting Table, query, form, or report Only fields and
records that are displayed in the current view or object are exported. Filtered records, hidden columns in a
datasheet, and fields not displayed on a form or report are not exported. The wizard respects the Format
property settings. For lookup fields, the lookup values are exported. For hyperlink fields, the values are
exported as hyperlinks. For rich text fields, the text is exported but the formatting is not. Choose the
destination workbook and file format. During the export operation, Access prompts you to specify the name of
the destination workbook. The following table summarizes when a workbook is created if it does not already
exist and when it is overwritten if it does already exist. If the destination workbook And the source object is
And you want to export Then A table, query, form, or report The data, with or without the formatting The
workbook is created during the export operation. Already exists A table or query The data, but not the
formatting The workbook is not overwritten. A new worksheet is added to the workbook, and is given the
name of the object from which the data is being exported. If a worksheet having that name already exists in the
workbook, Access prompts you to either replace the contents of the corresponding worksheet or specify
another name for the new sheet. Already exists A table, query, form, or report The data, including the
formatting The workbook is overwritten by the exported data. All existing worksheets are removed, and a new
worksheet having the same name as the exported object is created. The data in the Excel worksheet inherits the
format settings of the source object. The data is always added in a new worksheet. You cannot append the data
to any existing worksheet or named range. Run the export operation If the destination Excel workbook is
open, close it before you continue. In the Navigation Pane of the source database, select the object that you
want to export. Export only a portion of the data If the object is a table, query, or form, and you want to export
only a portion of the data, open the object in Datasheet view and select the records you want. To open a form
in Datasheet view: Double-click the form to open it. Right-click the form, and then click Datasheet View. If
this option is not available: Press F4 to display the Property Sheet task pane. Select Form from the drop-down
list at the top of the Property Sheet. On the Design tab, in the Views group, click Datasheet View. Note You
cannot export a portion of a report. However, you can select or open the table or query that the report is based
on, and then export a portion the data in that object. On the External Data tab, in the Export group, click Excel.
In the Export - Excel Spreadsheet dialog box, review the suggested file name for the Excel workbook Access
uses the name of the source object. If you want, you can modify the file name. In the File Format box, select
the file format that you want. If you are exporting a table or a query, and you want to export formatted data,
select Export data with formatting and layout. For more information, see the section Prepare for the export
operation. Note If you are exporting a form or report, this option is always selected but unavailable it appears
dimmed. To view the destination Excel workbook after the export operation is complete, select the Open the
destination file after the export operation is complete check box. If the source object is open, and if you
selected one or more records in the view before starting the export operation, you can select Export only the
selected records. To export all the records displayed in the view, leave this check box cleared. Note This check
box remains unavailable dimmed if no records are selected. If the export operation fails because of an error,
Access displays a message that describes the cause of the error. Otherwise, Access exports the data and,
depending on your selection in step 7, opens the destination workbook in Excel. Access then displays a dialog
box in which you can create a specification that uses the details from the export operation. Save the export
specification Click Yes to save the details of the export operation for future use. Saving the details helps you
repeat the same export operation in the future without having to step through the wizard each time. In the Save
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as box, type a name for the export specification. Optionally, type a description in the Description box. If you
have Microsoft Outlook installed on your computer, and you want to perform the export operation at fixed
intervals such as weekly or monthly , select the Create Outlook Task check box. Doing this creates an Outlook
task that lets you run the export by clicking a button in Outlook. If Outlook is installed, Access starts it. Note
If Outlook is not installed, an error message appears. If Outlook is not configured correctly, the Outlook
Startup Wizard starts. Follow the instructions in the wizard to configure Outlook. In Outlook, review and edit
the task settings such as Due date and Reminder. To make the task recur, click Recurrence, and fill in the
details. Click Save and Close. Run a saved export In the Outlook Navigation Pane, click Tasks, and then
double-click the task that you want to run. In Excel, open the destination workbook, and then verify that all the
data were copied into the correct cells. If you chose to copy only the data and not the formatting into an
existing workbook, the workbook might contain multiple worksheets. Locate the sheet that corresponds to the
export operation, and review the cells on that sheet. Troubleshoot missing and incorrect values The following
table describes various ways of troubleshooting common errors. Tip If you find that just a few values are
missing, fix them in the Excel workbook. Otherwise, fix the source object in the Access database, and then
repeat the export operation. Issue Description and resolution Calculated fields The results of calculated fields
are exported; the underlying expressions that perform the calculations are not. Multivalued fields Fields that
support multiple values are exported as a list of values separated by semicolons ;. Pictures, objects, and
attachments Graphical elements such as logos, contents of OLE object fields, and attachments that are part of
the source data are not exported. Add them to the worksheet manually after you complete the export operation.
Graph When you export a form or report that contains a Microsoft Graph object, the graph object is not
exported. Data in the wrong column Null values in the resulting worksheet are sometimes replaced by the data
that should be in the next column. Missing date values Date values earlier than Jan 1, are not exported. The
corresponding cells in the worksheet will contain a null value. Missing expressions Expressions that are used
to calculate values are not exported to Excel. Only the results of the calculations are exported. Manually add
the formula to the Excel worksheet after you complete the export operation. Missing subforms, subreports, and
subdatasheets When you export a form, report, or datasheet, only the main form, report, or datasheet is
exported. You must repeat the export operation for each subform, subreport, and subdatasheet that you want to
export. Missing or incorrectly formatted columns If none of the columns appear to be formatted in the
resulting worksheet, repeat the export operation, being sure to select the Export data with formatting and
layout check box in the wizard. Conversely, if only some columns appear to be formatted differently from the
versions in the source object, apply the formatting that you want manually in Excel. Format a column in Excel
Open the destination Excel workbook, and then display the worksheet that contains the exported data.
Right-click a column or a selected range of cells, and then click Format Cells. This can be the result of starting
the export operation from the Navigation Pane or in Form view. To resolve this issue, open the form in
Datasheet view before exporting the data. Error indicators or error values Check the cells for error indicators
green triangles in the corners or error values strings that begin with the character instead of the appropriate
data.
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